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F1+ A 7]+ B |Interaction
fe =1 -1 -1 +1
fe 2 -1 +1 -1
fe>3 +1 -1 -1
fe 4 +1 +1 +1

Y5 =Y+ (Y, —Y2)

2
AB2 5 (e Yy—-Y)—-(Y,-Y) (h+Y,) (Y2+7Y3)
2 2 2
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A dcH vs, R I IEH

—

B3 Ei(1,2,3)x % 2 Bi5kE(A, B, C)

90 90
88 | Fill Rate a8 | Fill Rate
86 | 86 |
84 |
) 84 g
82 | -
o | e 7 —— B 82 | T 1
—e— 152 80 | R o A2
78 | - 3 -+ - 13
76 . . 78 ' '
A B o} A B c
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27> 23

28>722 A[B[C[D[E[F|G
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FI*A | F1FB | B+ C A A [# A [+ [+ [+

1] il il A A [ H [+ A+
A gl il R T I I R
pe23 | 1 P I I I R e
pra] A | il A [+ [+ [+ ] A ]

Orthogonal Design: i e - {Fenidfo s F >
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Example 5-5.doe: 3% ¥R B d 4] S B>t A ) 5 el B E 4

num_A | num_B |Kanban 2
2 2 2
2 2 3
2 3 2
2 3 3
3 2 2
3 2 3
3 3 2
3 3 3

3

Response: % se# 41 & output rate
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Arena: Tools

PAN: Process Analyzer

> Process Analyzer

& Process Analyzer - [Project]]

1 [Insert > Scenario

= =

File Edit View\Insey) Tools Run Help

D d|SmE|[@w|=e|s gl =
_ —ux Scenario Properties
Project Items Displas R
Scenarics S Name Program File ‘ :P
+ Controls Double click here to add a new scenario
Responses
- Charts r N
Scenario Properties u
MName:
Scenario 1
Tool Tip Text
Scenario Name
Program Fils
HisimBaokExample 65 — I
= i scenarjo(treatment)
— PR % -\
Status. Version: 25 LeE ﬁ 7 e ﬂa‘—*
Pragram File OK.
ok || Cancel | [ Hep
< m | r
% Project || s=us
NKFUST Simulation Chapter 6 — Experimental Design and Optimization Slide 11
$X 2 -3 -
| —=
i A # 5
B Process Analyzer - [Project2.pan] =8 X
File Edit View Insert Tools Run Help
Insert > Control ﬂ
ST TR
— Scemario Properties
Proctliems  Displa
& Scenarios 5 Hame mm_A
o Soonario 1 Visible| (o — g e
o Controls =
G mun_h  Visible|| | [ —
Responses Insert Control @
o Charts
G outputr.  Visible Click on the control you want from the candidates below.
Controls Type Wodel File Names
L1 User Specified
batch_size Varisble array  Example 5-5.p
nun, Variable Example 5-5.
< " ] »
% Projost [ 150es <[ i m »
Control Selection I}
Ready Nams
nurn_B &
Column Format
Data Typs:
ot -
Heading Toal Tip Text
num_B num_B(User Speciied Yeariable in Example 5-5.p)
Slide 12
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EH R RO T

@PrccessAr\alyzer—[Projectl] =B S
> File Edit View Insert Tools Run Hel
p
DEd &8m A7
= Scenario Properties Controls Response
Project Items Displa; B
- Scenarios S| Name Program File :" num_A ‘ num_B ‘ Kanban 2 | output rate
6 Scemacio | Visibl| [t _
[l ¥ “Scenario 1 26 Example. 0 2 2 2 =
G mum_A - Visibl
srmnp Vbl | [insert Response =)
& Rﬁ‘f Ranban 2 Visible Click on the response you want from the candidates below.
esponses
o ot rte Visibe Responses Tye Model Fils Namss
Charts Entity
Quene
_— Resource
System
- User Specified
batch_size Variable Amay  Example 5-5.p
num_A Variable Example 5-5.p
num_B aricble Example 5
E
<] n »
% Project |[] St <[ m »
Response Selection S
P
Ready Narne:
output rate r
Column Format
N, o 14 . Decimal Places:
K THERS bsp o
Heading Tool Tip Text
auputrate autputrate(User Specified Outaut in Example 55.)
NKFUST Simulation Chapter 6 — Experimental Design and Optimization Slide 13
R AR FIFF R
8 Process Analyzer - [Projectl]
File Edit View Insert Tools Run Help
el &
= Controls Response
Project Items Displa &
- Scenarios Program File j" num_A num_B Kanban2 | output rate
G Scenario | Visibl
i Scenario 2 Visibl Bigamee. 2 2 2 z =
6 Scenario 3 Visibls e "‘ 3 3 3 5 =
6" Scenario 4 Visibls S =
6 Scensrio 5 Visibl 2 E=wic| O 2 3 J =
69" Scenario Visibls 43 Eeme O 3 2 2 =
6" Scenario 7 Visibls 25 Bamps 0 3 2 3 =
& Scenario 8 Visible 26 - Example . 0 3 3 2 =
& Controls Example | 0 3 3 3 —
‘;; :m:g z:::iz Doubls-slick here to add a new scenar.
G Kanban2  Visible
- Responses
& cutput rate Visible
Charls
< m »
3 Project [[ Joms ]
Run selected scenarios A NUM
B BT R IR g . T
1. /f Bl:E 4% #7F Scenarios » 3% God b T FE3L
B ¥ £ Yk
2. 84 ¢ & *.pan
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PAN p #3 7 i

num_A | num_B |Kanban 2| Output Rate | AB Interaction
1 -1 -1 -1 0.584 +1
2 -1 -1 +1 0.598 +1
3 -1 +1 -1 0.585 -1
4 -1 +1 +1 0.595 -1
5 +1 -1 -1 0.621 -1
6 +1 -1 +1 0.626 -1
7 +1 +1 -1 0.610 +1
8 +1 +1 +1 0.615 +1

(0.621 + 0.626 + 0.610 + 0.615)  (0.584 + 0.598 + 0.585 + 0.595)

= 0.0275
4 4
0.584 +0.598 + 0.610 + 0.615  0.585+0.595 + 0.621 + 0.626) 0.005
4 4 -
NKFUST Simulation Chapter 6 — Experimental Design and Optimization Slide 15

Process Analyzeri & ¥ 3%

. Arenap ¥R Ex# Process Analyzer °
e 1= Z7TerProject » & & ¢ 41 {53 Projectig {713 % o
o j¥Insert:f ¥ :£ # Insert Scenario » 4% F 45 ) 4258 e 74§ o

o j&Insert:£ ¥ if #% Insert Control » » j}u{f;" o e s L]
LIRS E S

e jiInsertif H i¥ # Insert Response » At el pEH R &
A A e A o

o [£4 4 » ArerScenario IR F KK L A KL F)F vk E oo

e £ #77 Scenarios > fX{& 4% P44 FProcess Analyzerit

=X
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PAN¢1 5

% Process Analyzer - [Projectl.pan] =B X
File Edit View Insert Tools Run Help
4 = = g 21 & im x?
EF
Scenario Properties Controls Response S € 7T
T T - * i &€ # Response
= Scenarios Name Program File :" num_A num_B [P output rate » . N .
6 Seenario 1 Visible | = Scenaro 126 Example 20 2 2 2 *&E ’ J’Qnsertlﬁ H FiE
6 Seenario 2 Visiblg| | Scenario 226 - Example 20 i 3 5
6 Scenario 3 Visible PN
t
G Seomario 4 Vidbl : Scenario 3 26 Bai\e 3 pi 3 3 ;}’& Chart
é Seonario 5 Visibla| B Chart Wizard: Step 1 of 4 - Chart Type
o Senario s Vistle| [ 2]
@ Scenario 7 Visibld| [ €]
Chart Objestive:
G Scenario 8 Visiblg| [ 7] A
 Cononls B © Compare the average valuss of a response across scenarios
ot Visblel| [ Compare the replication values of & response for a single scenario
6/mum B Vidble . .
e Yty Chart Type: Sample:
© Responses — —
¢ outputrate Visible
Charts
< m » Display confidence intervals and range of data for response values
O againsta scenazio name or control value, Scenarios must contain
% Project ||| Sons xee or more completed replications to be include:
Ready
—
o : 4
£ #% Box and Whisker £ % ]
[T=#aw-] [ ®my | [ @8 |

NKFUST Simulation
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Identify Best Scenarios
Bigger is better

89 Process Analyzer - [Project.pan] =8 X
File Edit View Insert Teols Run Help
Dl &m £ &4 [ X2
=l Scenario Properties Controls Response
Project ltems Displs =
- Scenarios S| Name Program File ‘:" num_A num_B Kanban 2 [ECEED)
6 Seemario | Visibly| 1= Scenaio 1 26 Example : 20 2z 2 2
6 Scenario 2 Visible
S eantio s Vigbld| |28 Scenario? 726 Example | 20 2 2 3
G Seommtiod Viabld| | 2] Scenario3 26 Example 20 2 3 2
o Scenario 5 Visibl | | 4 |8 N - i
: Chart Wizard: Step 4 of 4 - Set axis categories
6 Seenario 6 Visible| | 5 |
G Scenatio 7 Visible| | 6 |4
6 Scenario 3 Visibls| | 7 | X axis orientation (degrees):
- Controls | 8] " -
gomum A Visible oo Data set identifiers:
Grmn B Visible Scenario 1
G Kanban 2 Visible Scenario 2 —
& Responses || |Scenario3 — R |
& outputrate Visible Scenario 4
Charts Scenario §
Scenario 6
Scenario 7
Scenario §
|
i i
. » t t !
— — i i i
% Project ||| saus
Ready 4 Flldenity Ber Sommard Show beet semnarion g
—

@ Bigger is bettg
Smaller 15 better

6-Scenario 6

Error Tolerance:  0.004163

SER HUH

[==#® |

J

A

J
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% & R 2 P BE R 1E ehScenario

Scenario 6: num_A=3, num_B=2, Kanban 2=3

+ LA
ﬁ B R4

output rate by Scenario

l
U -k-k

6.1

0

JY ot o2 ok La? N ot o®

) 0 ] o 0 O 0 0
%da“"“ o Cgi\'a“ o d?“‘a‘\ & da“"}o %di‘@“ %Ee,o@“ ‘5@(""0 %@(\9‘\ @
EE o ' ' ' ' ' ' " soenan
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PR WS WS LRy

o AREABAEFNEE o X BX, 0 i RANE B A T

BfRA &SR H Maximize f (x4, x,) RAEASEE Y F
AR EHEFIEE — qubjecttox; +x, <6 B6EE
g LA

2x1 + 3%, <10« REBHERF 7
L8 me S xy,x, >0 108 =
3H e 4B

o fgEE Eit L EZE RV E PR SES %R BB X eRR
B~ BT o B S A A B 2 Xp) e st
o FAEFDEXEXHE PR P d P RE
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fei s % BT flx e x,18) Bt f(xy xy)

Questions: F — # % AVRIB >
wd 28ER e 24 539

Xy

Question: ar%f(x]+gvx2+5)w xe 9
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OptQuest for Arena

1. B fxExample 4-3 15.doe » i£ ¥ Tools > OptQuest for Arena
2. File > New Project
3. & New Projectih P i #% Optquest optimization

{8 Arena Visual Designer Training & Evaluation Mode - Commercial Use Prohibited

File Edit View Tools Window Help 4, :j*: J]'& _}_}@ ﬁﬂArenaﬁ_;“
(DSHI-2R| 200 %

[Creste new project]
Hodel1

Twould like to start my project with: Description

7S i

1618 Example 4-2 v13.doe
Dashboard Optquest

visualization  visualization  eptimization

Creates a Visual Designer
project that contains an
initizl Optaest.
optimization. The 3D scene
and/or Dashboard may be
added if desired.

Name Example 4-3 v15.a23
Lowstio  FiSimulation'20 16 (m)]

Create directory for document
Browse | [k [ Camad

NKFUST Simulation Chapter 6 — Experimental Design and Optimization Slide 25

OptQuestH T /i &

[ Optquest optimization 4.a23 - Arena Visual Designer Training & Evaluation Mode - Commercial Use Prohibited - [Optimization 1¢] [=E] %]

File Edit View Run Tools Window Help =[x
D3GR [OMX PriIvI?E —0—|v
Toolbox x| ki Optimization 1*_| MBI

) OptQuest Optimization

»|e Constraint Controls Summary
P Objective Included Catedorv. Name  Element Type Type LowBound  Suqgested Value Hiah Bound Step
¥ Suggested Solution User Speciied Variable Continuous | 270 300 330
‘Continuous
User Specfied | 458 | Variable Continuous |0 0 o VA
User Specfied (778 | Variable Continuous | 180 200 Tool window
User Specfied ¥ | Variable Continuous |0 0 Project Explorer %
User Specified | (T52: Variable Continuous |90 100 ‘Oplquest optimization 4
User Specified | #8%5 Variable Continuous |6.3 7 a =] Oplw
PP Optimization | -
. @ Graphic Filss |8 Open Editor
ips
Drag and Drop above items to Edit E Hii_Export OptQuest
B = V@ copy  culec
foitoibloien * Properties - Optimiz. Sename
it Optimization 1 X Delete
(2 Best Solutions 7 Properties
(3 Constraints =
b Optimizati
Specified 4 Replications
T Confiden 10
LR (Variable) Fixed  True =
BFE (Varisble) YoiBiE H Maximu 10
SR (Variable) A f’g o % T Minimus 2
N Replicati 1
4 Solutions
Solutions C:\Userslst:
A 4 Stop Options
(22 Suggesied Solutions Antomati False -
<« n % Rbm
Name of the optimization.
For Help. press F1 P Ready

NKFUST Simulation Chapter 6 — Experimental Design and Optimization Slide 26




How OptQuest Controls Arena

o AitH & & & chArenafz it o £ OptQuest

e OptQuest§ = > ¥ #]Arena > 7| 14238 p #75 ¥ #4] h % dic(controls) &

¢ F_% ¢h4 »z(responses)

o g4 Y¥iEi H (editor explorer) » 3% ¥ & B $¥cd % L 4p B
o T MiBEH > & —‘F,’z;{ F L4 5" (constraints) &2 & i { chp £ 5

(objective)
e Project Explorerz % % e & = fic i )k F cnif 12
e When the optimization runs:

= OptQuest ¥ #]Arena#z ;¢ ¢ * f¥cauE R @ » B 4018 (7 W3R
= Arena #-#-# % % 2 % 0ptQuesti™iz

= OptQuestilfpio® &2 A i b % > A EIAE 2 A4 30— w4

o ﬁ%%Arena@f?fiﬁ.f’
" EREAEAEEA BRSSP AR RIER

e OptQuest i & i » Arenafz.;% w48 £ %k %

-

3T

NKFUST Simulation Chapter 6 — Experimental Design and Optimization Slide 27
=, S
R LS EAIEF § [
Y
SR E IR 3
. i
S B - [
Yii Optimization 1° |
Controls A
[ |
Induded Cateaory Name Element Tvpe Tvoe Low Bound Suaaested  Hiah Bound Step
User Specfied | F[R Variable Discrete 200 300 800 10
=] User Specified = TEm$r Variable Continuous 0 0 0 N/A
[} User Specfied HEE Variable Continuous 0 0 0 N/A
1} User Specfied |EZE Variable Continuous 180 200 220.000000... |N/A
1} User Specfied |#&EE Variable Continuous 1] 0 0 N/A
User Speciied | 578 Variable Discrete 100 100 400 10
> User Specified |88 Variable 1 7 40 1
Binary
Continuous
Integer -
. . —
Discrete:Z 74 7

High Bound — Low Bound
Step

112k € Step Size
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9 3 Optquest & if B

i 5%

Example 4-3 v15.a23 - Arena Visual Designer Training & Evaluation Mode - Commercial Use Prohibited - [Optimization 1] [=[=] x ]
File Edit View Run Tools Window Help Tool window X
D9 hOR 200K IPrIIE] ———|¢ Project Explorer e
e —— Example 4-3 v15
Toolbox x|t optimization 1-_| 5 0 OptQuest Cptimizations
1 Optuest Gpti mization Responses ! 253 Optimization 1
»le Constraint Responses Summary (@ Craphic Files
) Objective Included Category  Data Tvpe
# Suggested Solution
.. output Output Value
User Spedi... Output 2HHEESE  Output Value
User Spedi... | Output E55A&  Output Value
] ENTITIES |NVACost | zNVACost | Taly Value Properties - ZHHEE (OUt...x
a ENTITIES |NVATme | zNVATme Taly Value
] ENTITIES  Other Cost | z.OtherCost |Tally Value 4 B:
Tips [ BT
Drag and Drop above items 1o Edit Explorer ] ENTITIES _|Other Time |z OtherTime |Taly Value EHIHEE
(] ENTITIES  |TotalCost  |z.TotalCost | Tally Value 4 Optimization
Editor Explorer x [a] ENTITES | TotalTme | zTotalTime | Tally Value - gd“dgd True
esponse -
st Solutions - | ENTITIES | TranCost | zTranCost |Taly Value
wnstraints = & Name
atrols ENTITIES | TranTime | zTranTime | Taly Value Mams of resoonse
ser Specified 1 ] ENTITIES | VA Cost ZVACost Taly Value
) _EBR (Variable) 3 [
FEREE Variable) ENTITIES VA Time ZNATIme Tally Value
%g% (Variable) ] ENTITIES | Wait Cost  |z.WaitCost | Tally Value
i (Variable) _
BaE (\/::i:bli) @] ENTITIES |Wait Tme  |zWatTime | Taly Value
HE! (Variable) ] Entity NumberIn | customer.... |Output Value
- B (Variable) _
ectives ] Entity Number OQut | customer.... |Output Value
simization ] Enti NVA Cost | customer.... |Tally Value
e’e— Response - y by
bl m » 0 Entity NVATmMe  customer... Taly Value -
For Help. press F1 Example 4-3 v15.doe Ready
NKFUST Simulation Chapter 6 — Experimental Design and Optimization Slide 29
7
a Example 4-3 v15.a23 - Arena Visual Designer Training & Evaluation Mode - Commercial Use Prohibited - [Optimization 1%] ‘ =B X ‘
File Edit View Run Tools Window Help =gl
D2 | @R[ Z2[(OCX PP H| —¢
Toolbox x| Bl Optimization 1* | E]ajE|
2 OptQuet Oplimization Constraints 2. B 5°H FzOptExpression
#l¢ Constraint R — 3
DD Included | Mame Type  Description Exprossion N

YO p—

4Add

4 Suggestad Solution

Tips

Drag and Drop above items to Edit Expll |

v\ ¥ Jlcon.. [NenLi.. Fosizms: [

[REREER] / (£EHER)

+ [EERRER] ~=050

sl OptExpression

= B -

= Controls
_EBE (Variable)
FTEE (Variable)
JEIRH (Variable)
EResponses
2EHEE Oniput Valoe)
2EMHREE (Ouput Value)
BHFAE ©utput Value)

Editor Explorer

mization 1
Best Solntions
Constraiuts

Constraint 1
Controls

User Specified

PR (Variable)

TEZE, (Variable)

3
i
s
I

e

sinh <osh tanh

Expression

[2EHES]/ (2EEES] +

Check Expression

[2EIEREED »= 090

& I 3£ $190% 4

ik pok

(:]’nnr‘imnc - > . 1
For Help, press F1 Example 4-3 v15.dee Ready |
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KEHxEMP &

8 Example 4-3 v15.a23 - Arena Visual Designer Training & Evaluation Mode - Commercial Use Prohibited - [Optimization 1] [=[a] %]
File Edit View Run Tools Window Help =lelx
OD3E h@MZM0 X PrI»H?E O 4

Toolbox x| i 1| jeajuajes

5 OptQuest Otinization Objectives Summary 3 2. {3 £z OptExpression
#|e Constraint. Obiectives .
£ Objective
" Included Name Tvoe Goal Description Expression
¥ Suggested Solution =
v \ /) |objective 1 NonLinear | Minimize [msmne [ VS EA] ]
85 OptExpression = |5 [
= c°’j;%1§ Tool window
R (Variable) Project Bxpl
FIEB (Variable) roject Explorer x
i 4 (Variable) | Example 4-3v15
Responses 2 OptCQuest
EEHEE Output Valie) 23} Optimization 1
AR Output Value) (@ Graphic Files
s EHAA Output Value)
Drag and Drop above items to Edit E
Editor Explorer x
K Optimization |
(2 Best Solutions
(23 Constraints
1 2 & Controls d U7 0
. JFQ\- =3 (3 Objectives =
; sl Properties - Objecti... %
A || comne
(2 Responses [aBasic 4]
" (3 Suggested Solutions Sum All Controls (<]
Name  Objective |
Expression 4+ Objective
[f==Fz3] E Descripti BiAE/MI
Expressic [F H A
Goal  Minimize
Type | NONLINE .
Name
Name of the Obiective.
For Help. press F1 Example 4-3 v15.doe ———
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Project Explorer ®

Example 4-3 v15
= 3 CptQuest Optimizatiens

> M Optimization |
(@ Graphic Files

Properties - Optimization 1 x

Optimization 1

4 Replications
Confidence lnterval Percent 10
—=> Fixed False 5 R 2 T B iz
1 Maximum Replications 100 LY f*,qu‘ B %
Minimum Replications 10 i’f’lﬁ:ﬁﬂ' gt
Replications 1

N

Solutions
Solutions Log
4 Stop Options

C:AUserststaff\Documents\OptQuest

Automatic Stop False
2 —> Manual Stop False
——> Number of Simulations 300
Run. Oaly Suggested Solutions | False % 300 & ]

True

lations

4 Tolerance

Tolerance False

Use Number Of Simulations
Indicates the optimization will stov after Number of Simulations is reached,

B B4R 5 tloghh

4L

S

6.2
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B i 1 iE AR HP SR B

= | [

=[x

I

Example 4-3v15.a23 - Arena Visual Designer Training & Evaluation Mode - Commercial Use Prohibited [Run Mode] - [Optimization 1]
File Edit View Run Tools Window Help
L LR ) IR S A L Rl o—¢
%l Optimization 1 |
biective Status Best Simulation 9
BestVale  \17004618 )  |Feasible Running Simulation 25
Replication | of 10
Current Value
Control Name /" Best Valne Current Value Constraint Type Statns
iR [ lsso 650 (Constraint | |Non Linssr | Fessible
FIEE \ 310 ) 100
i 0/
Objective Values
34, — Feasible
. |nfeasible
30.6 ‘
3 272 \
% ‘
& 2. ‘
20.4] 1
17 R
0 5 10 15 20 2 30 35 40 45 50
Simulation
For Help. press F1 Example 43 vi5.doe
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Optquest?| d) & &

Optquest®| 4% & % *a23 » R B4 & & *opt
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